HELP MENU – USER’S GUIDE
TRAFFIC NOISE MODEL 3.1

FHWA-HEP-21-042
FEDERAL HIGHWAY ADMINISTRATION
OFFICE OF NATURAL ENVIRONMENT
Washington, D.C.
Notice

This document is disseminated under the sponsorship of the Department of Transportation in the interest of information exchange. The United States Government assumes no liability for the contents or use thereof.

The United States Government does not endorse products or manufacturers. Trade or manufacturers’ names appear herein solely because they are considered essential to the objective of this report.
The Federal Highway Administration (FHWA) with the assistance of the Volpe Center Acoustics Facility finalized the Traffic Noise Model (TNM) version 3.1. This document is the information found in the Help Menu inside TNM 3.1. It is being provided as a separate report, in addition to being embedded inside TNM 3.1, to assist users prior to using the model for the first time.

The Federal Highway Administration (FHWA) with the assistance of the Volpe Center Acoustics Facility finalized the Traffic Noise Model (TNM) version 3.1. This document is the information found in the Help Menu inside TNM 3.1. It is being provided as a separate report, in addition to being embedded inside TNM 3.1, to assist users prior to using the model for the first time.
CONTENTS

1. INTRODUCTION ................................................................................................................................. 7
  1.1 TECHNICAL SUPPORT ....................................................................................................................... 7

2. TNM HOMEPAGE .................................................................................................................................. 8

3. TNM TOOLBAR ...................................................................................................................................... 9
  3.1 FILE TAB ........................................................................................................................................... 9
    3.1.1 CREATING A NEW PROJECT ........................................................................................................ 9
    3.1.2 OPENING A PROJECT ................................................................................................................. 12
    3.1.3 SAVING A PROJECT .................................................................................................................... 12
    3.1.4 PRINTING A PROJECT ................................................................................................................. 12
    3.1.5 CLOSING A PROJECT ................................................................................................................. 12
    3.1.6 IMPORTING A PROJECT ............................................................................................................ 12
    3.1.7 EXITING ...................................................................................................................................... 12
  3.2 EDIT/MODIFY TAB ............................................................................................................................ 13
    3.2.1 SHARED TOOLS FUNCTION ....................................................................................................... 13
    3.2.2 RECEIVERS, BARRIERS, ROADWAYS, TREE ZONES, BUILDING ROWS, TERRAIN LINES, GROUND ZONES, AND CONTOUR ZONES SELECT FUNCTIONS ........................................................................ 14
  3.3 VIEW TAB .......................................................................................................................................... 14
    3.3.1 SYNC 3D GEOMETRY FUNCTION .............................................................................................. 14
    3.3.2 SYNC 3D VIEW FUNCTION ......................................................................................................... 14
    3.3.3 EXAGGERATE HEIGHTS FUNCTION .............................................................................................. 14
    3.3.4 ZOOM EXTENT FUNCTION .......................................................................................................... 15
    3.3.5 START SECTION FUNCTION ....................................................................................................... 15
    3.3.6 TOGGLE ALL POINT LABELS FUNCTION .................................................................................. 15
    3.3.7 TOGGLE ALL OBJECT LABELS FUNCTION ............................................................................... 15
  3.4 SETTINGS TAB .................................................................................................................................. 15
    3.4.1 APPLICATION SETTINGS FUNCTION .......................................................................................... 15
    3.4.2 PROJECT SETTINGS FUNCTION ................................................................................................ 17
  3.5 CALCULATE TAB ............................................................................................................................... 18
    3.5.1 SHARED FUNCTION .................................................................................................................... 19
    3.5.2 RECEIVERS FUNCTION .............................................................................................................. 19
    3.5.3 PARALLEL BARRIER (CALCULATE SECTION) FUNCTION ....................................................... 19
    3.5.4 INPUT CHECKING FUNCTION .................................................................................................... 19
  3.6 BARRIER ANALYSIS TAB .................................................................................................................. 19
    3.6.1 MODE FUNCTION ........................................................................................................................ 20
    3.6.2 CURRENT ANALYSIS FUNCTION .............................................................................................. 20
    3.6.3 EXISTING ANALYSIS FUNCTION .............................................................................................. 21
  3.7 CONTOURS TAB ............................................................................................................................... 21
    3.7.1 CONTOUR LEVELS FUNCTION .................................................................................................. 21
    3.7.2 CALCULATE CONTOUR FUNCTION .......................................................................................... 22
  3.8 REPORTS TAB .................................................................................................................................... 23
    3.8.1 INPUT REPORTS FUNCTION .................................................................................................... 23
    3.8.2 RESULTS REPORTS FUNCTION ................................................................................................. 24
  3.9 TOOLS TAB ....................................................................................................................................... 24
3.9.1 NAVIGATION HISTORY FUNCTION ................................................................. 24
3.9.2 MEASURE FUNCTION .................................................................................... 24

3.10 HELP TAB ........................................................................................................ 25

4. LEGEND PANEl .................................................................................................... 26

5. VIEW PANEl ........................................................................................................ 27
5.1 PLAN BUIILDEr ................................................................................................. 27
5.2 3D VIEW ............................................................................................................ 28
5.3 SECTION VIEW .................................................................................................. 28
5.4 REPORT VIEW ................................................................................................... 29

6. EDIT PANEl: EDIT TAB ........................................................................................ 30
6.1 EDITING RECEIVERS ....................................................................................... 30
  6.1.1 TO EDIT THE BASIC FEATURES OF A RECEIVER .................................. 31
  6.1.2 TO EDIT THE LEVELS/Criteria FEATURES OF A RECEIVER ............. 31
6.2 EDITING BARRIER DEFAULTS ......................................................................... 31
  6.2.1 TO EDIT THE BASIC FEATURES OF A BARRIER .................................... 32
  6.2.2 TO EDIT THE WALL REFLECTION FEATURES OF A BARRIER .......... 32
  6.2.3 TO EDIT THE SEGMENT FEATURES OF A BARRIER ............................ 32
  6.2.4 TO EDIT THE WALL UNIT COST FEATURES OF A BARRIER .......... 32
6.3 EDITING ROADWAY DEFAULTS ...................................................................... 32
  6.3.1 TO EDIT THE BASIC FEATURES OF ROADWAYS ................................ 33
  6.3.2 TO EDIT THE MULTI-LANE SETTINGS OF ROADWAYS ...................... 33
6.4 EDITING TERRAIN LINE DEFAULTS .................................................................. 34
  6.4.1 TO EDIT THE BASIC FEATURES OF TERRAIN LINES .......................... 34
6.5 EDITING BUILDING ROW DEFAULTS ............................................................... 34
  6.5.1 TO EDIT THE BASIC FEATURES OF BUILDING ROWS ......................... 35
  6.5.2 TO EDIT THE MEASUREMENTS FEATURES OF BUILDING ROWS .......... 35
6.6 EDITING TREE ZONE DEFAULTS ..................................................................... 35
  6.6.1 TO EDIT THE BASIC FEATURES OF TREE ZONES ................................. 35
  6.6.2 TO EDIT THE GROUND INFO FEATURES OF TREE ZONES .................. 35
  6.6.3 TO EDIT THE MEASUREMENTS FEATURE OF TREE ZONES ............... 36
6.7 EDITING GROUND ZONE DEFAULTS ............................................................... 36
  6.7.1 TO EDIT THE BASIC FEATURES OF GROUND ZONES .......................... 36
  6.7.2 TO EDIT THE GROUND INFO OF GROUND ZONES ............................. 36
6.8 EDITING CONTOUR ZONE DEFAULTS ............................................................... 37
  6.8.1 TO EDIT THE BASIC FEATURES OF CONTOUR ZONES ....................... 37
  6.8.2 TO EDIT THE MEASUREMENTS FEATURES OF CONTOUR ZONES ....... 37

7. EDIT PANEl: SEARCH AND GEOCODE TABs ..................................................... 38
7.1 SEARCH TAB ..................................................................................................... 38
  7.1.1 TO SEARCH FOR AN ITEM ...................................................................... 38
7.2 GEOCODE TAB .................................................................................................. 38
  7.2.1 TO OBTAIN A GEOCODE ADDRESS ...................................................... 38

8. OBJECT DETAILS PANEl ...................................................................................... 40
8.1 TNM DATA ENTRY EFFICIENCY TIPS ................................................................. 41
8.2 RECEIVERS DETAIL SUB-PANE .................................................................... 41
  8.2.1 TO VIEW AND EDIT THE RECEIVERS THAT HAVE BEEN ADDED TO THE
       PROJECT MAP ......................................................................................... 41
8.3 BARRIERS DETAIL SUB-PANE ...................................................................... 41
  8.3.1 TO VIEW AND EDIT THE BARRIERS THAT HAVE BEEN ADDED TO THE
       PROJECT MAP ......................................................................................... 41
8.4 ROADWAYS DETAIL SUB-PANE .................................................................... 42
  8.4.1 TO VIEW AND EDIT THE ROADWAYS THAT HAVE BEEN ADDED TO THE
       PROJECT MAP ......................................................................................... 42
8.5 TERRAIN LINES DETAIL SUB-PANE .............................................................. 42
  8.5.1 TO VIEW AND EDIT THE TERRAIN LINES THAT HAVE BEEN ADDED TO THE
       PROJECT MAP ......................................................................................... 42
8.6 TREE ZONES DETAIL SUB-PANE .................................................................. 42
  8.6.1 TO VIEW AND EDIT THE TREE ZONES THAT HAVE BEEN ADDED TO THE
       PROJECT MAP ......................................................................................... 42
8.7 CONTOUR ZONES DETAIL SUB-PANE ........................................................... 43
  8.7.1 TO VIEW AND EDIT THE CONTOUR ZONES THAT HAVE BEEN ADDED TO THE
       PROJECT MAP ......................................................................................... 43
8.8 GROUND ZONES DETAIL SUB-PANE ............................................................. 43
  8.8.1 TO VIEW AND EDIT THE GROUND ZONES THAT HAVE BEEN ADDED TO THE
       PROJECT MAP ......................................................................................... 43
8.9 BUILDING ROWS DETAIL SUB-PANE ........................................................... 42
  8.9.1 TO VIEW AND EDIT THE BUILDING ROWS THAT HAVE BEEN ADDED TO THE
       PROJECT MAP ......................................................................................... 42
8.10 USER-DEFINED VEHICLES DETAIL SUB-PANE ........................................ 43
  8.10.1 TO VIEW AND EDIT THE USER-DEFINED VEHICLES THAT HAVE BEEN ADDED TO
       THE PROJECT MAP .................................................................................. 43
8.11 OUTPUT DETAIL SUB-PANE ....................................................................... 44
8.12 PROJECT INFORMATION DETAIL SUB-PANE ............................................. 44
8.13 CALCULATION RESULTS DETAIL SUB-PANE .............................................. 44

9. DRAWING ON THE MAP .............................................................................. 44
9.1 ADDING RECEIVERS TO THE MAP ............................................................... 47
  9.1.1 TO ADD A RECEIVER ............................................................................ 48
9.2 ADDING BARRIERS TO THE MAP ............................................................... 48
  9.2.1 TO ADD A BARRIER ............................................................................. 48
9.3 ADDING A ROADWAY TO THE MAP .......................................................... 49
  9.3.1 TO ADD A ROADWAY .......................................................................... 49
9.4 ADDING TERRAIN LINES TO THE MAP ...................................................... 50
  9.4.1 TO ADD A TERRAIN LINE .................................................................... 50
9.5 ADDING BUILDING ROWS TO THE MAP ................................................... 51
  9.5.1 TO ADD BUILDING ROWS .................................................................... 51
9.6 ADDING TREE ZONES TO THE MAP ......................................................... 52
  9.6.1 TO ADD A TREE ZONE .......................................................................... 52
9.7 ADDING GROUND ZONES TO THE MAP .................................................... 53
  9.7.1 TO ADD GROUND ZONES .................................................................... 53
9.8 ADDING CONTOUR ZONES TO THE MAP .................................................. 54
  9.8.1 TO ADD A CONTOUR ZONE .................................................................. 54

SI* (Modern Metric) Conversion Factors
LIST OF FIGURES

FIGURE 1 TNM TOOLBAR .................................................................................................................. 9
FIGURE 2 FILE TAB AND MENU........................................................................................................ 9
FIGURE 3 NEW PROJECT WINDOW ................................................................................................. 10
FIGURE 4 SHARED TOOLS FUNCTION .......................................................................................... 13
FIGURE 5 SEGMENTS button and sub-menu .................................................................................... 13
FIGURE 6 AVAILABLE SELECT buttons with Icons ........................................................................ 14
FIGURE 7 VIEW Tab .......................................................................................................................... 14
FIGURE 8 SETTINGS Tab ................................................................................................................... 15
FIGURE 9 APPLICATION SETTINGS Dialog Box ........................................................................... 16
FIGURE 10 PROJECT SETTINGS Dialog Box .................................................................................... 17
FIGURE 11 CALCULATE Tab .............................................................................................................. 18
FIGURE 12 BARRIER Analysis Tab .................................................................................................... 20
FIGURE 13 TNM WORKSPACE with LINE-OF-SIGHT check and END Analysis buttons ............... 21
FIGURE 14 CONTOURS Tab ............................................................................................................... 21
FIGURE 15 CONTOUR LEVELS Dialog Box ..................................................................................... 22
FIGURE 16 SOUND LEVEL Contour ................................................................................................. 22
FIGURE 17 NOISE Reduction Contour ............................................................................................ 23
FIGURE 18 LEVEL Difference Contour ............................................................................................. 23
FIGURE 19 Tools Tab ........................................................................................................................ 24
FIGURE 20 HELP Tab ........................................................................................................................ 25
FIGURE 21 VIEW Pane Tabs ............................................................................................................ 27
FIGURE 22 PLAN Builder ................................................................................................................ 27
FIGURE 23 3D View ........................................................................................................................ 28
FIGURE 24 SECTION View ................................................................................................................ 29
FIGURE 25 REPORT View ................................................................................................................ 29
FIGURE 26 EDIT Receiver Pane ...................................................................................................... 30
FIGURE 27 EDIT Barrier Pane .......................................................................................................... 31
FIGURE 28 EDIT Roadway Pane ...................................................................................................... 33
FIGURE 29 EDIT Terrain Line Pane .................................................................................................. 34
FIGURE 30 EDIT Building ROW Pane .............................................................................................. 34
FIGURE 31 EDIT Tree Zone Pane .................................................................................................... 35
FIGURE 32 EDIT Ground Zone Pane ............................................................................................... 36
FIGURE 33 EDIT Contour Zone Pane ............................................................................................... 37
FIGURE 34 SEARCH sub-pane ......................................................................................................... 38
FIGURE 35 GEOCODE sub-pane (ESRI-only) .................................................................................. 39
FIGURE 36 OBJECT Details Pane Menu ........................................................................................... 40
FIGURE 37 AN ADDED Receiver in PLAN Builder ......................................................................... 48
FIGURE 38 AN ADDED Barrier in PLAN Builder ............................................................................ 49
FIGURE 39 ADDED Roadways in PLAN Builder ............................................................................ 50
FIGURE 40 AN ADDED Terrain Line in PLAN Builder ................................................................. 51
FIGURE 41 ADDED BUILDING ROWS in PLAN Builder .............................................................. 52
FIGURE 42 AN ADDED Tree Zone in PLAN Builder ...................................................................... 53
FIGURE 43 AN ADDED Ground Zone in PLAN Builder ............................................................... 54
FIGURE 44 AN ADDED Contour Zone in PLAN Builder ............................................................... 55
WELCOME TO THE FHWA’s TNM 3.1 ONLINE HELP

I. INTRODUCTION

The Federal Highway Administration (FHWA) Traffic Noise Model (TNM) is a computer program that is used to analyze highway traffic noise to assist in the design and development of highway noise barriers. TNM computes the effect of intervening ground (defined by its type, or optionally by its flow resistivity) with theory-based acoustics that have been calibrated against field measurements. In addition, TNM allows sound to propagate underneath selected intervening roadways and barriers, rather than being shielded by them. During calculation, TNM perturbs intervening barriers up and down from their input height, to calculate for multiple heights. Then during acoustical design of selected barriers, combined with selected receivers, TNM displays sound-level results for any combination of height perturbations. It also contains an input height check, to determine if noise barriers break the lines-of-sight between sources and receivers. In addition, it provides summary cost and benefit information for each barrier design, from user-supplied unit barrier costs and land-use information. For selected cross sections, TNM also computes the effect of multiple reflections between parallel barriers or retaining walls that flank a roadway. The TNM user can then enter the computed parallel-barrier degradations as adjustment factors for individual receivers in TNM’s calculation of receiver sound levels.

The TNM is provided by FHWA as a Standalone Application and includes a batch processing tool as well. This User Guide specifically covers the functionality provided by the TNM Standalone Application.

Detailed instructions on how to operate the TNM Standalone Application are comprised of the following topics:

1. **TNM HOMEPAGE**
2. **TNM TOOLBAR**
3. **LEGEND PANE**
4. **VIEW PANE**
5. **EDIT PANE: EDIT TAB**
6. **EDIT PANE: SEARCH AND GEOCODE TABS**
7. **OBJECT DETAILS PANE**
8. **DRAWING ON THE MAP**

I.1 TECHNICAL SUPPORT

If you need assistance with TNM contact TNMHelp@dot.gov.
2. **TNM Homepage**

The TNM Homepage consists of the toolbar and individual function panes. The homepage is designed to be user-friendly. The mouse and keyboard are used to navigate, draw, and perform TNM noise modeling. The homepage contains the following functional areas:

**TNM Toolbar**

The toolbar, located at the top of the user interface by default, contains File, Edit/Modify, View, Settings, Calculate, Barrier Analysis, Contours, Reports, Windows, and Help tabs.

**Legend Pane**

The Legend Pane, located at the left of the user interface by default, shows layers and/or features that have been added to the Plan Builder.

**View Pane**

The View Pane, located at in the center of the user interface by default, includes the Plan Builder View, 3D View, Section View, and Report View sub-panes.

**Edit Pane: Edit Tab**

The Edit Pane, located at the right of the user interface by default, lists the sub-panes for objects that can be edited including barriers, building rows, contour zones, ground zones, receivers, roadways, terrain lines, and tree zones.

**Edit Pane: Search and Geocode Tabs**

The Search Panes, located at the right of the user interface by default, include sub-panes for Search, Bookmarks\(^1\), Annotation\(^2\), and Geocode functions.

**Object Details Pane**

The Object Details Pane, located at the bottom of the user interface by default, allows the user to review the individual attribution of each object in the TNM project being viewed.

---

1. The bookmarks sub-pane will be deprecated in a future version of TNM.
2. The Annotation sub-pane will be deprecated in a future version of TNM.
3. **TNM Toolbar**

The TNM Toolbar is used to perform various functions of TNM. You can minimize or maximize the toolbar by right clicking and selecting Minimize the Ribbon.

![Figure 1 TNM Toolbar](image)

The toolbar consists of the following tabs:

1. **FILE TAB**
2. **EDIT/MODIFY TAB**
3. **VIEW TAB**
4. **SETTINGS TAB**
5. **CALCULATE TAB**
6. **BARRIER ANALYSIS TAB**
7. **CONTOURS TAB**
8. **REPORTS TAB**
9. **TOOLS TAB**
10. **HELP TAB**

### 3.1 **FILE TAB**

The File Tab is used to create **CREATING A New Projects**, **OPENING** a Project and **CLOSING** a Project Projects, **SAVING A Projects**, **PRINTING A Projects**, **IMPORTING A Projects**, and **EXITING** the TNM software.

![Figure 2 File Tab and Menu](image)

#### 3.1.1 **CREATING A NEW PROJECT**

To create a new project:

1. Click the File Tab.
2. Click New Project. The New Project window displays.
3. Enter the Organization for the Project.
4. Enter the Contract for the New Project.
5. Define the Project Projection Settings by selecting one of the Cartesian, Geographic, or Projected radio buttons. Please note that depending on that selection you might need to also select a value from the Category and System pull down lists.

- **Cartesian** coordinates are based on spatial positions described by a pair of coordinates indicating that position’s relationship to a fixed origin on a 2-dimensional plane of infinite distance. This system is most often utilized in Computer Aided Design (CAD) software, and may or may not have a direct relationship with known coordinates on the Earth. The recommended Geographic Category and System selections from their respective pull-down menus to utilize in TNM for new projects in North America are Category = ‘Cartesian’ and System = ‘Cartesian 2D (Meters)’. Cartesian coordinates
correspond to the Orthographic system used in TNM 2.5. When importing a project from TNM 2.5 to TNM 3.0 users should verify that the Project is using Cartesian for this value.

- **Geographic** coordinates base spatial positions on a 3-dimensional spherical model of the earth and are often described in terms of longitude, latitude, and elevation. Latitude and longitude designations are typically described using decimal degrees or in degrees, minutes, and seconds. The recommended Geographic Category and System selections from their respective pull-down menus to utilize in TNM for new projects in North America are Category = ‘World’ and System = ‘WGS1984’ to leverage the WGS84 (EPSG: 4326) decimal degrees, since this is a standard in cartography and navigation/global positioning systems.

- **Projected** coordinates are based on a model of the surface of the Earth where the Earth’s surface is rendered as a flat, 2-dimensional surface. Different projected systems preserve or alter distance, shape/areas, and North directionality, among other factors that should be taken into consideration when selecting a projected system. The recommended Projected settings to utilize in TNM for new projects in North America are Category = ‘World’ and System = ‘WebMercator’ to leverage the WGS84 Web Mercator (EPSG: 3857) meters, since it is the de facto standard for web mapping applications.

6. Select the Traffic. Choose from:
   - $L_{Aeq1h}$ - Volumes, Speeds
   - $L_{Aeq1h}$ - Percent Volumes, Speeds
   - $L_{dn}$ - Day Night
   - $L_{den}$ - Day Evening Night

7. Select the Report Metric for $L_{Aeq}$. Choose From:
   - $L_{A\text{ Avg}}$
   - $L_{A10}$
   - $L_{A50}$

8. Update the Relative Humidity value, if needed.
9. Update the Temperature value, if needed.
10. Select a Ground Type. Choose from:
    - Pavement
    - Water
    - Hard Soil
    - Loose Soil
    - Lawn
    - Field Grass
    - Granular Snow
    - Powder Snow

11. Update the LOS Distance Limit to define the Line of Sight distance, if needed.
12. Enter a Name for your New project.
13. Enter a Description of the New project.
14. Click Create to create the New Project.
15. Click Cancel at any time to cancel the new project creation.

### 3.1.2 Opening a Project

To open an existing project:

1. Click the File Tab.
2. Click Open Project. A file explorer window will display.
   - If the Open Project option isn’t available, close the current project.
3. Navigate to the file you would like to open.
4. Select your project and click the Open button to open the project.
5. Click Cancel at any time to cancel opening a project.

### 3.1.3 Saving a Project

To Save a Project or Save a Project As:

1. Click the File Tab.
2. Click Save Project. The project is now saved.
3. Click Save Project As.
4. Enter a Project Name and Click Save.

### 3.1.4 Printing a Project

To Print a Project:

1. Click the File Tab.
2. Click Print Project.

### 3.1.5 Closing a Project

To close a project:

1. Click the File Tab.
2. Click Close Project.

### 3.1.6 Importing a Project

To Import a Project:

1. Click the File Tab.
2. Click Import From XML. A file explorer window will display.
3. Navigate to the file you would like to open.
4. Select your project and click the Open button to import the project.
5. Click Cancel at any time to cancel importing a project.

### 3.1.7Exiting

To Exit the TNM software:
1. Click the File Tab.
2. Click Exit. The TNM software closes.

3.2 EDIT/MODIFY TAB

The Edit/Modify tab lists the **SHARED TOOLS FUNCTION**, and the **RECEIVERS, BARRIERS, ROADWAYS, TREE ZONES, BUILDING ROWS, TERRAIN LINES, GROUND ZONES, AND CONTOUR ZONES SELECT FUNCTIONS**. When editing a feature, you must first select that feature on the map. A feature can be selected on a map by clicking on that feature with the mouse or by using the Edit/Modify tab to easily access multiple feature selection options.

### 3.2.1 SHARED TOOLS FUNCTION

The Shared Tools function provides Delete, Undo, Redo, Edit, Segments, and Enable Object Add buttons for features that have been selected on the map.

![Figure 4 Shared Tools Function](image)

To delete a feature that has been selected click the Delete button.

To undo or redo adding and removing of objects click the Undo or Redo buttons.

See the **EDIT Pane: Edit Tab** for more specific information on editing a feature.

See the **EDIT Pane: Edit Tab** for more specific information on editing a feature.

![Figure 5 Segments button and sub-menu](image)

1. In the Segments function window enter a Divide (Length) to divide a feature by length.
2. Enter a Divide (Number) to divide a feature by a number amount (i.e. divide into 4 sections).
3. Click Combine Objects to combine selected objects on the map.
4. Click Divide Object At to select a point to divide combined objects.

See the **EDIT Pane: Edit Tab** for information on editing a feature’s defaults.

The Enable Object Add button acts as the "D" key to enable drawing of objects. It can be toggled on and off.
3.2.2 RECEIVERS, BARRIERS, ROADWAYS, TREE ZONES, BUILDING ROWS, TERRAIN LINES, GROUND ZONES, AND CONTOUR ZONES SELECT FUNCTIONS

1. To edit receivers, barriers, roadways, tree zones, building rows, terrain lines, ground zones, or contour zones you must first select the feature. To select a feature on the map, click the Selection button for that object. You may also single click the object to select it.
2. Click Select, Select All, or Deselect All to edit the chosen feature on the map.

In the EDIT Pane: Edit Tab, the selected feature’s default attributes are displayed and can be edited. See the EDIT Pane: Edit Tab for more specific information on editing a feature’s default attributes.

3.3 VIEW TAB

The View tab lists the Sync 3D Geometry Function, Sync 3D View Function, Exaggerate Heights Function, Zoom Extent Function, Start Section Function, Toggle All Point Labels Function, and Toggle All Object Labels Function.

3.3.1 Sync 3D Geometry Function

To sync the 3D geometry:

1. Click the Sync 3D Geometry button.
2. The Plan Builder and 3D View will refresh and display identical data in their respective formats.

3.3.2 Sync 3D View Function

To sync the 3D view:

1. With both the Plan Builder and 3D View windows open click the Synch 3D View button.
2. The 3D View and Plan Builder will refresh and display the same features.

3.3.3 Exaggerate Heights Function

If you wish to exaggerate the height of objects when viewing it in the 3D View, click the Exaggerate Heights button. Objects that have height will be exaggerated on the 3D View Map.
3.3.4 **ZOOM EXTENT FUNCTION**

Selecting the Zoom Extent button will zoom the map to visually include all objects.

3.3.5 **START SECTION FUNCTION**

To make a Section:

The Start Section Function replaces the Skew View from earlier versions of TNM. It allows you to select a section line on the map to view details of the items on the map along the section line.

1. Click the Start Section button.
2. Click and drag a line across the map to select all of the features that line crosses.
3. The Section View will now display all of the features that are included in the section line you created.

3.3.6 **TOGGLE ALL POINT LABELS FUNCTION**

The Toggle All Point Labels allow you to show or hide the point labels on the map.

3.3.7 **TOGGLE ALL OBJECT LABELS FUNCTION**

The Toggle All Object Labels allow you to show or hide the object labels on the map.

3.4 **SETTINGS TAB**

The Settings Tab contains the **APPLICATION SETTINGS FUNCTION** and **PROJECT SETTINGS FUNCTION**.

![Figure 8 Settings Tab](image)

3.4.1 **APPLICATION SETTINGS FUNCTION**

Prior to opening or creating a project you can apply specific settings to the application. **Applying these settings allows you to tailor the application to your own preferences to be used every time you create a new project.**

To adjust the Application Settings, click the Application Settings button. The Application Settings dialog box appears.
1. In the Application Settings dialog box click Project Defaults in the left column. Settings you choose here will be applied to all newly created reports.
2. Enter an Organization Name.
3. Enter a Contract.
4. Enter user information in Analysis By.
5. Select a Unit of Measure from the drop-down list. Choose English or Metric.
6. Select a Traffic measurement from the drop-down. Choose from:
   - $L_{Aeq} \text{1h} - \text{Volumes, Speeds}$
   - $L_{Aeq} \text{1h} - \text{Percent Volumes, Speeds}$
   - $L_{dn} - \text{Day Night}$
   - $L_{den} - \text{Day Evening Night}$
7. Select the Report Metric for $L_{Aeq}$. Otherwise this box will be disabled. Choose From:
   - $L_A \text{ Avg}$
   - $L_{A10}$
   - $L_{A50}$
8. Enter a Relative Humidity.
9. Enter a Temperature.
10. Select a Ground Type from the drop-down. Choose from:
    - Custom
    - Pavement
    - Water
    - Hard Soil
    - Loose Soil
    - Lawn
    - Field Grass
    - Granular Snow
    - Powder Snow
11. Click Save Settings to save the settings.
12. Click Cancel to abandon the changes.

### 3.4.2 PROJECT SETTINGS FUNCTION

Project Settings can be changed for any project that has been created. Any Application Settings that have been made will be applied to Project Settings.

To adjust the Project Settings, click the Project Settings button. The Edit Project dialog box appears.

![Figure 10 Project Settings Dialog Box](image)

1. Enter or change the Organization Name.
2. Enter or change the Contract.
3. Enter or change the Analysis By.
4. Select or change the Project Projection Settings through adjustments to the three radio buttons and their corresponding pull-down menu Category and System values.
5. Select or change the Traffic measurement from the drop-down. Choose from:
6. Select the Report Metric for \( L_{Aeq} \). Choose from:
   - \( L_{Aeq1h} \) - Volumes, Speeds
   - \( L_{Aeq1h\%} \) - Percent Volumes, Speeds
   - \( L_{dn} \) - Day Night
   - \( L_{den} \) - Day Evening Night

7. Select or change the Relative Humidity.

8. Select or change the Temperature.

9. Select or change the Ground Type from the drop-down. Choose from: Custom
   - Pavement
   - Water
   - Hard Soil
   - Loose Soil
   - Lawn
   - Field Grass
   - Granular Snow
   - Powder Snow

10. Select or change the LOS Distance Limit.

11. Check the “Enable state plane adjustment” checkbox to enable the option. Scale and Offset can be selected as radio buttons and X/Y coordinates can be entered. There is also a checkbox to maintain aspect ratio.

12. Enter a name for the Project.

13. Enter a Description for the project.

14. Click Save Settings to save the settings.

15. Click Cancel to abandon the changes.

### 3.5 Calculate Tab

The Calculate tab lists the **Shared Function**, **Receivers Function**, **Parallel Barrier (Calculate Section) Function**, and **Input Checking Function**.

After setting up a project and applying all the needed features to the map, you can calculate the noise level of traffic via noise receivers that have been strategically placed in the area of interest. These calculations are used to assist in the design of noise barriers.
3.5.1 **Shared Function**

The Shared Function contains the Cancel Calculation button. The Cancel Calculation button is enabled when a calculation is running and disabled when a calculation is not running. Click the Cancel Calculation to cancel a running calculation.

3.5.2 **Receivers Function**

The Receivers Function contains the Set Active, All Receivers, and Active Receivers buttons.

1. The Set Active options allow you to toggle the activation of receivers to be used for the calculate functions.
2. To calculate all active and inactive receivers using a single thread, click the All Receivers button. Open the drop-down menu and select “All Receivers in parallel” to enable multi-threaded computation.
3. To calculate only the active receivers using a single thread, click the Active Receivers button. Open the drop-down menu and select “Active Receivers in parallel” to enable multi-threaded computation.

*Note: Parallel processing is currently a beta feature in TNM 3.1 to reduce computation time in early modeling stages. It should not be used to compute final noise levels reported for regulatory analyses.*

3.5.3 **Parallel Barrier (Calculate Section) Function**

The Parallel Barrier Calculate Section Function allows the user to define a section line between two parallel barriers and calculate the degradation of sounds levels taking into consideration the sound way bouncing between those two parallel barriers.

1. To initiate the section line, press the Calculate Section button.
2. Hover your cursor over the point at which you want to begin the section line.
3. Click the left mouse button once to start the section line and move the cursor to the final end position and click the left mouse button a second time.
4. View the resulting calculation.

3.5.4 **Input Checking Function**

The Input Checking Function contains the Check Inputs button. Click the button to validate the project data that has been input.

3.6 **Barrier Analysis Tab**

The Barrier Analysis tab is used when determining the optimal heights for each barrier segment when barrier perturbations have been included in the calculations. The Barrier Analysis tab list the **Mode Function**, **Current Analysis Function**, and **Existing Analysis Function**. The user cannot begin to employ the Barrier Analysis Tab tools until they have completed a study calculation and can now analyze the results of that study.
3.6.1 **Mode Function**

The Mode Function contains the Start Analysis button. To start an analysis of the barriers for your project click the Start Analysis button. The results of this action will be to set up a Plan Builder window next to a 3D View window with the TNM objects in the project that were just analyzed. At the bottom of the interface the user will see the Receivers (Active) Table appear on the left with data on Receivers and two Barrier Design Tables that can be selected with tabs at the bottom right of the application. Along the right side of the interface the Barrier Analysis Tool window appears listing each segment of barriers with the option to perturb the barrier up and down.

After the Barrier Analysis workflows complete, and the user wants to resume their other TNM activities, they would press the End Analysis button.

3.6.2 **Current Analysis Function**

The Current Analysis Function contains the Save and LOS Check buttons. The Save button allows the user to save different barrier analysis designs to identify which would provide the optimal results. To save your current analysis click the Save button. You will be prompted to enter a name for the analysis file. Only the Name is for the analysis as it is stored in the Project on your local database.

The LOS (Line of Sight) Check function enables the user to validate if the user’s barrier design properly breaks the line of sight between the receiver and the roadway. The results provide graphic lines connecting the receivers selected for the analysis to the barriers identified for the analysis. The user must select at least one receiver and one barrier segment for this function to operate. Green graphic rays are properly breaking the line of sight. Yellow graphic rays indicate a partial obstruction, while Red graphic rays indicate a lack of obstruction.
3.6.3 Existing Analysis Function

The Existing Analysis function contains the Load button (see Figure 12 Barrier Analysis Tab). To load an existing analysis, click the Load button. The Load Barrier Analysis Edit dialog box appears.

3.7 Contours Tab

The Contours tab can be used only after a contour has been selected.

3.7.1 Contour Levels Function

The Contour Levels Function allows the user to establish the range of contours that would be drawn based on the noise model outputs.
3.7.2 **CALCULATE CONTOUR FUNCTION**

The Calculate Contour Function contains the Sound Level, Noise Reduction, Level Difference, and Clear Contour buttons. With a Contour Zone selected, pressing the Sound Level, Noise Reduction, or Level Difference buttons will open the dialog boxes shown in the tables below (Figure 16 Sound Level Contour, Figure 17 Noise Reduction Contour, and Figure 18 respectively).

Once the desired design name is selected, the **OBJECT DETAILS Pane** will switch to the **CALCULATION RESULTS DETAIL SUB-PANE** so that you can track progress. Once the contour is calculated, the grid file will automatically be saved.

Once a contour has been generated and the project closed, the contour can be redisplayed by clicking on the Load Grid File icon and selecting the appropriate grid file.
3.8 **REPORTS TAB**

The Reports Tab lists the **INPUT REPORTS FUNCTION** and **RESULTS REPORTS FUNCTION**. Each Reports function contains links to reports that are visible in the **REPORT VIEW** window.

### 3.8.1 **INPUT REPORTS FUNCTION**

The Input Reports Function contains links to the Input Reports. Click any report link to view the report in the **REPORT VIEW** window. The following Input Reports are listed:

- Receivers
- Barriers
- Ground Zones
- Roadways
- Receiver Adjustment Factors
- On-Structure Barriers
• Tree Zones
• Traffic for TNM Vehicles
• Terrain Lines
• Reflecting Barriers
• Contour Zones
• Traffic for User Defined Vehicles
• Building Rows

3.8.2 RESULTS REPORTS FUNCTION

The Result Reports Function contains links to the Result Reports. Click any report link to view the report in the REPORT VIEW window. The following Result Reports are listed:

- Sound Levels - No Barrier Objects
- Sound Levels Diagnosis by Road Segment
- Sound Levels - Input Heights
- Sound Levels Diagnosis By Barrier Segment
- Barrier Descriptions
- Sound Levels Diagnosis by Vehicle Type - Input Heights
- Barrier - Segment Descriptions

3.9 TOOLS TAB

The Tools tab lists Navigation History Function and Measure Function.

![Figure 19 Tools Tab](image)

3.9.1 NAVIGATION HISTORY FUNCTION

Navigation allows you to view Previous and Next navigation points. The Previous and Next buttons cycle recent map locations in the VIEW PANCES.

To navigate to the previous and next map location click the Previous button to go back and click the Next button to go to the next map location.

3.9.2 MEASURE FUNCTION

1. Click the Measure Distance button.
2. Hover your cursor over the point at which you want to begin measuring a distance.
3. Click your left mouse button once to begin the measuring line.
4. Drag your mouse to the location at which you want to end measuring the distance, noting that
the current distance is labelled at the beginning, along, and at the end of the graphic measurement line.

5. Single click the left mouse button to end that measure segment and continue with another segment, or,

6. Double click the left mouse button to end that measurement line.

7. View the resulting measurement line graphic and its distance label. Distance units are dictated by the Units of Measure in the Project Settings.

3.10 Help Tab

The Help Tab contains links to the Getting Started Guide, the User Manual/Help Menu (i.e. this document), and version information for TNM.

Click the Getting Started button to access the Getting Started Guide, the Help button to access the User Manual, and the About button to access the version information for TNM.

[Image: Figure 20 Help Tab]
4. **Legend Pane**

The Legend Pane displays the layers and/or features that have been added to a project map. When you apply a feature to the map, such as a roadway, it will be listed in the Legend Pane. Once a feature is listed in the Legend Pane, you can choose whether to have that feature viewable on the map and you can increase or decrease its transparency.

**To enable/disable legend features on the map:**

1. Click the check-box next the feature in the Legend Pane.
2. To view the feature, ensure the check-box is checked.
3. To adjust the transparency of the legend item on the map use the slider bar by sliding it left to increase transparency and right to decrease transparency.
4. To remove the feature from the map, un-check the check-box.
5. View Pane

The View Pane display the map and associated map data using different visualization methods. The View Pane is comprised of the following four sub-panes used to represent project data in various visualization forms: **PLAN BUILDER**, **3D**, **SECTION VIEW**, and **REPORT VIEW**.

![View Pane Tabs](image)

**Figure 21 View Pane Tabs**

5.1 Plan Builder

The Plan Builder sub-pane displays the map in a top-down 2D format in which the user designs projects. The majority of project design is done in the Plan Builder. See also: [DRAWING ON THE MAP](#).

To view the map in Plan Builder:

1. Click the Plan Builder sub-pane. The map will be displayed.
2. Click and hold the left mouse button and drag the mouse to pan the map left or right.
3. Roll the mouse wheel to zoom in and out.
4. Click right mouse button to bring up a drop-down list of the following functions:
   - Zoom to Best View
   - Clear Selection
   - Select All
   - Select All of Type: Receivers, Barriers, Roadways, Terrain Line, Building Row, Tree Zone, Ground Zone, or Contour Zone

![Plan Builder](image)

**Figure 22 Plan Builder**
5.2 3D View

The 3D View sub-pane displays the map in a three-dimensional format. The 3D view is a three-dimensional representation of the 2D view. Viewing the map in 3D allows you to see contours and heights of terrain.

To view the map in 3D view:

1. Click the 3D View sub-pane. The map will be displayed in a three-dimensional format.
2. Click and hold the right mouse button and drag the mouse to pan the map left or right.
3. Click and hold the middle mouse wheel and drag the mouse to rotate the map on an axis.
4. Click and Hold the left mouse button and drag the mouse to zoom in and zoom the map.

![Figure 23 3D View](image)

5.3 Section View

The Section View sub-pane displays a cross section of the map where sector lines have been drawn using the Start Selection Function. The Section View is used to show distances and elevation changes.

To view the map in Section view:

1. Click the Start Section icon in the Basic Tools, found in the View Tab.
2. Click with the left mouse button in the Plan Builder.
3. Move the cursor, drawing a sector line through the objects that you want to see in the Section View.
4. Click with the left mouse button in the Plan Builder again to end the cut.
5. The Section view will display the cross section selected.
6. Roll the mouse wheel to zoom in and out of the section view.
5.4 REPORT VIEW

The Report View sub-pane displays reports for the open project.

To view the Report view:

1. Click the Report View sub-pane. A list of reports will be displayed.
2. Use the toolbar buttons on the Report view to scroll pages, print reports, save, etc.
6. **EDIT Pane: Edit Tab**

The Edit Pane contains all of the editing functions for TNM object default values. To edit default values, click the Edit tab in the Tools Window. The following editing functions are listed:

- **EDITING RECEIVERS**
- **EDITING BARRIER DEFAULTS**
- **EDITING ROADWAY DEFAULTS**
- **EDITING TERRAIN LINE DEFAULTS**
- **EDITING BUILDING ROW DEFAULTS**
- **EDITING TREE ZONE DEFAULTS**
- **EDITING GROUND ZONE DEFAULTS**
- **EDITING CONTOUR ZONE DEFAULTS**

6.1 **EDITING RECEIVERS**

The Edit Receivers Pane provides functions to edit receiver defaults for all receivers that have not yet been added to the map. Default changes will not apply to receivers that have already been added to the map.

To edit receiver defaults, click the Receiver icon 🎤.

![Figure 26 Edit Receiver Pane](image-url)
6.1.1 To Edit the Basic Features of a Receiver

1. Enter or use the up/down arrows in the fill box to change the # of Receptors.
2. Check or un-check the Active check-box.
3. Enter or use the up/down arrows in the fill box to change the height of the selected receiver.
4. Enter text in the fill box to change the Name of the selected receiver.
5. Enter text in the fill box to change any Notes.

6.1.2 To Edit the Levels/Criteria Features of a Receiver

1. Enter or use the up/down arrows in the fill box to change the Existing Level.
2. Enter or use the up/down arrows in the fill box to change the Impact Increase.
3. Enter or use the up/down arrows in the fill box to change the Impact Level.
4. Enter or use the up/down arrows in the fill box to change the Noise Reduction Goal.

6.2 Editing Barrier Defaults

The Edit Barriers Pane provides functions to edit barrier defaults for all barriers that have not yet been added to the map. Default changes will not apply to barriers that have already been added to the map.

To edit barrier defaults, click the Barrier icon.

Figure 27 Edit Barrier Pane
6.2.1 **To Edit the Basic Features of a Barrier**

1. Select the Barrier Type to be Wall or Berm.
2. Enter or use the up/down arrows in the fill box to select the Maximum Height.
3. Enter or use the up/down arrows in the fill box to select the Minimum Height.
4. Enter or change the Name of the barrier.
5. Enter or change any Notes about the barrier.

6.2.2 **To Edit the Wall Reflection Features of a Barrier**

1. Enter or use the up/down arrows in the fill box to increase or decrease the NRC Left‐Side.
2. Enter or use the up/down arrows in the fill box to increase or decrease the NRC PBA.
3. Enter or use the up/down arrows in the fill box to increase or decrease the NRC Right‐Side.

6.2.3 **To Edit the Segment Features of a Barrier**

1. Check or un‐check the check‐box to apply the For Noise Abatement feature.
2. Enter or use the up/down arrows in the fill box to select the Height in feet.
3. Enter or use the up/down arrows in the fill box to increase or decrease the Increment Size (ft).
4. Enter or use the up/down arrows in the fill box to increase or decrease the Increments Down.
5. Enter or use the up/down arrows in the fill box to increase or decrease the Increments Up.

6.2.4 **To Edit the Wall Unit Cost Features of a Barrier**

1. Enter or use the up/down arrows in the fill box to increase or decrease the Area dollar amount per square unit.
2. Enter or use the up/down arrows in the fill box to increase or decrease the Lineal dollar amount per linear unit.

6.3 **Editing Roadway Defaults**

The Edit Roadways pane provides functions to edit roadway defaults for all roadways that have not yet been added to the map. Default changes will not apply to roadways that have already been added to the map.

To edit roadway defaults, click the Roadway icon.
6.3.1 To Edit the Basic Features of Roadways

1. Use the drop-down list to select or change the Category. Choose from:
   - Mainline
   - Ramp
   - Shoulder
2. Enter or change the Name of the roadway.
3. Enter or change any Notes for the roadway.
4. Check or un-check the check-box to apply the On Structure feature.
5. Use the drop-down list to select or change the roadway Surface. Choose from the following pavement types:
   - Average
   - Dense Graded Asphalt
   - Open Graded Asphalt
   - Portland Concrete
6. Enter or use the up/down arrows in the fill box to select or change the Roadway Width.

6.3.2 To Edit the Multi-Lane Settings of Roadways

1. Check or un-check the check box to Enable Multi-Lane settings.
2. Check or un-check the check box to indicate the presence of an Inside Shoulder.
3. Enter the value of the Inside Shoulder Width.
4. Enter the number of lanes in the Number of Lanes row.
5. Check or un-check the check box to indicate the presence of an Outside Shoulder.
6. Enter the value of the Outside Shoulder Width.
6.4 **Editing Terrain Line Defaults**

The Edit Terrain Lines pane provides functions to edit terrain line defaults for all terrain lines that have not yet been added to the map. Default changes will not apply to terrain lines that have already been added to the map.

To edit terrain line defaults, click the Terrain Line icon 🏞️.

![Figure 29 Edit Terrain Line Pane](image)

6.4.1 **To Edit the Basic Features of Terrain Lines**

1. Enter or change the Name of the terrain line.
2. Enter or change any Notes for the terrain line.

6.5 **Editing Building Row Defaults**

The Edit Building Row pane provides functions to edit building row defaults for all building rows that have not yet been added to the map. Default changes will not apply to building rows that have already been added to the map.

To edit Building Row defaults, click the Building Row icon 🏢.

![Figure 30 Edit Building Row Pane](image)
6.5.1 **To Edit the Basic Features of Building Rows**

1. Enter or change the Name of the building row.
2. Enter or change any Notes for the building row.

6.5.2 **To Edit the Measurements Features of Building Rows**

1. Enter or use the up/down arrows in the fill box to increase or decrease the Average Height.
2. Enter or use the up/down arrows in the fill box to increase or decrease the Gap Percentage.

6.6 **Editing Tree Zone Defaults**

The Edit Tree Zones pane provides functions to edit tree zone defaults for all tree zones that **have not** yet been added to the map. Default changes will not apply to tree zones that have already been added to the map.

To edit tree zone defaults, click the Tree Zone icon.

![Figure 31 Edit Tree Zone Pane](image.png)

6.6.1 **To Edit the Basic Features of Tree Zones**

1. Enter or change the Name of the tree zone.
2. Enter or change any Notes for the tree zone.

6.6.2 **To Edit the Ground Info Features of Tree Zones**

1. Enter or use the up/down arrows in the fill box to select the Flow Resistivity.
2. Use the drop-down list to select or change the Ground Type. Choose from:
   - Custom
   - Pavement
   - Water
• Hard Soil
• Loose Soil
• Lawn
• Field Grass
• Granular Snow
• Powder Snow

6.6.3 To Edit the Measurements Feature of Tree Zones

1. Enter or use the up/down arrows in the fill box to select the Average Height in feet (ft).

6.7 Editing Ground Zone Defaults

The Edit Ground Zones pane provides functions to edit ground zones defaults for all ground zones that have not yet been added to the map. Default changes will not apply to ground zones that have already been added to the map.

To edit Ground Zone defaults, click the Ground Zone icon .

![Figure 32 Edit Ground Zone Pane](image)

6.7.1 To Edit the Basic Features of Ground Zones

1. Enter or change the Name of the ground zone.
2. Enter or change any Notes for the ground zone.

6.7.2 To Edit the Ground Info of Ground Zones

1. Enter or use the up/down arrows in the fill box to select the Flow Resistivity.
2. Use the drop-down list to select or change the Ground Type. Choose from:
   • Custom
• Pavement
• Water
• Hard Soil
• Loose Soil
• Lawn
• Field Grass
• Granular Snow
• Powder Snow

6.8 Editing Contour Zone Defaults

The Edit Contour Zone pane provides functions to edit contour zone defaults for all contour zones that have not yet been added to the map. Default changes will not apply to contour zones that have already been added to the map.

To edit Contour Zone defaults, click the Contour Zones icon.

![Figure 33 Edit Contour Zone Pane](image)

6.8.1 To Edit the Basic Features of Contour Zones

1. Enter or change the Name of the contour zone.
2. Enter or change any Notes for the contour zone.

6.8.2 To Edit the Measurements Features of Contour Zones

1. Enter or use the up/down arrows in the fill box to increase or decrease the Grid Height.
2. Enter or use the up/down arrows in the fill box to increase or decrease the Min. Grid Spacing.
3. Enter or use the up/down arrows in the fill box to increase or decrease the Tolerance value.
7. **EDIT PANE: SEARCH AND GEOCODE TABS**

The Edit Pane also contains two tabs for **SEARCH** Tab and Error! Reference source not found. functions. Click each sub-pane for more information.

### 7.1 SEARCH TAB

The default active sub-pane is Search, which is used to search for items that have been added to the map.

#### 7.1.1 To Search for an Item

1. Click the Search sub-pane in the Tools window. The Search interface appears.

![Search Sub-pane](image)

2. Type the name of the item you want to search for.
3. Click the hourglass icon or hit Enter on the keyboard to begin the search. Results matching your search criteria will display. (Partial results will also begin to appear as you type.)
4. Click a result to view it on the map.

### 7.2 GEOCODE TAB

The Geocode Sub-pane is used to obtain Geocode addresses from a location on the map.

#### 7.2.1 To Obtain a Geocode Address

1. Click the Geocode sub-pane in the Tools window. The Geocode interface appears.
2. Check the Pick from Map check-box to obtain a geocode address from a selected point on the map.
3. Click a point on the map. The Geocode Address displays.
4. Enter an address to obtain the Geocode Address from a known address.
5. Click the Geocode Address button. The Geocode Address displays.
8. **Object Details Pane**

The Object Details Pane lists the details for each feature that has been added to the project map.

The Detail panes consist of the following sub-panes:

- **Receivers Detail Sub-Pane**
- **Barriers Detail Sub-Pane**
- **Roadways Detail Sub-Pane**
- **Terrain Lines Detail Sub-Pane**
- **Building Rows Detail Sub-Pane**
- **Building Rows Detail Sub-Pane**

The Building Rows Detail sub-pane contains the details for each building row that has been added to the project map. You can view and edit the Building Rows, Points, and Segments.

**8.1.1 To View and Edit the Building Rows That Have Been Added to the Project Map**

1. Click the Building Rows Detail sub-pane.
2. Click Building Rows in the left column to view and edit the list of building rows.
3. Click Points in the left column to view and edit the points of each building row.
4. Click Segments in the left column to view and edit the segments of each building row.

- **Tree Zones Detail Sub-Pane**
- **Ground Zones Detail Sub-Pane**
- **Ground Zones Detail Sub-Pane**

The Ground Zones Detail sub-pane contains the details for each ground zone that has been added to the project map. You can view and edit the Ground Zones, Points, and Segments.

**8.1.2 To View and Edit the Ground Zones That Have Been Added to the Project Map**

1. Click the Ground Zones Detail sub-pane.
2. Click Ground Zones in the left column to view and edit the list of groundzones.
3. Click Points in the left column to view and edit the points of each ground zone.
4. Click Segments in the left column to view and edit the segments of each ground zone.

- **Contour Zones Detail Sub-Pane**
8.2 TNM Data Entry Efficiency Tips

TNM provides multiple techniques and tools that assist users in entering the attribute values for objects to reduce the time necessary to set up complex models. Here are a few tips:

- When editing roadway object segment attributes in the lower data grid, TNM 3.1 allows users to click the Copy Down button for repetitive Traffic attribute copying and pasting full rows of values.
- TNM 3.1 allows the user to select one or more rows from the lower data grid for an object, use Ctrl-C to copy the data, and then in an active MS Excel spreadsheet use Ctrl-P to paste the data into the spreadsheet including the column headings.
- TNM 3.1 allows the user when editing Receivers to establish rows of properly structured values in MS Excel, use Ctrl-C to copy the rows of data in MS Excel, and then in the TNM Receiver data grid the user selects a current row in the Receivers tab, uses Ctrl-P to paste the new row into the table. Please note that due to the need to preserve proper geometries of more complex line and polygon objects, this paste function is limited to only Receivers, whose geometry is a single point, and not the other line and polygon objects.

8.3 Receivers Detail Sub-Pane

The Receivers Detail sub-pane contains the details for each receiver that has been added to the project map. You can view and edit the Receivers, Level/Criteria, and Adjustment Factors.

8.3.1 To View and Edit the Receivers That Have Been Added to the Project Map

1. Click the Receivers Detail sub-pane.
2. Click Receivers in the left column to view the list of receivers.
3. Click Level/Criteria in the left column to view and edit the level/criteria of the receivers.
4. Click Adjustments Factors in the left column to view and edit adjustment factors for specific receiver/roadway pairings.

8.4 Barriers Detail Sub-Pane

The Barriers Detail sub-pane contains the details for each barrier that has been added to the project map. You can view and edit the General settings, Points, Segments, Structure, and Reflections of each barrier.

8.4.1 To View and Edit the Barriers That Have Been Added to the Project Map
1. Click the Barriers Detail sub-pane.
2. Click Barrier in the left column to view and edit the general settings of each barrier.
3. Click Points in the left column to view and edit the points of each barrier.
4. Click Segments in the left column to view and edit each point of a barrier.
5. Click Structure in the left column to view and edit the structure of each barrier.
6. Click Reflections in the left column to view and edit the reflections of each barrier.

8.5 ROADWAYS DETAIL SUB-PANE

The Roadways Detail sub-pane contains the details for each roadway that has been added to the project map. You can view and edit the Roadways, Points, Segments, Traffic, and Flow Control.

8.5.1 TO VIEW AND EDIT THE ROADWAYS THAT HAVE BEEN ADDED TO THE PROJECT MAP

1. Click the Roadways Detail sub-pane.
2. Click Roadways in the left column to view and edit the list of roadways.
3. Click Points in the left column to view and edit the points of each roadway.
4. Click Segments in the left column to view and edit the segments of each roadway.
5. Click Traffic in the left column to view and edit traffic of each roadway.
6. Click Flow Control in the left column to view and edit the flow control of each roadway.

8.6 TERRAIN LINES DETAIL SUB-PANE

The Terrain Lines Detail sub-pane contains the details for each terrain line that has been added to the project map. You can view and edit the Terrain Lines, Points, and Segments.

8.6.1 TO VIEW AND EDIT THE TERRAIN LINES THAT HAVE BEEN ADDED TO THE PROJECT MAP

1. Click the Terrain Lines Detail sub-pane.
2. Click Terrain Lines in the left column to view and edit the list of terrain lines.
3. Click Points in the left column to view and edit the points of each terrain line.
4. Click Segments in the left column to view and edit the segments of each terrain line.

8.7 BUILDING ROWS DETAIL SUB-PANE

The Building Rows Detail sub-pane contains the details for each building row that has been added to the project map. You can view and edit the Building Rows, Points, and Segments.

8.7.1 TO VIEW AND EDIT THE BUILDING ROWS THAT HAVE BEEN ADDED TO THE PROJECT MAP

5. Click the Building Rows Detail sub-pane.
6. Click Building Rows in the left column to view and edit the list of building rows.
7. Click Points in the left column to view and edit the points of each building row.
8. Click Segments in the left column to view and edit the segments of each building row.
8.8 Tree Zones Detail Sub-Pane
The Tree Zones Detail sub-pane contains the details for each tree zone that has been added to the project map. You can view and edit the Tree Zones, Points, and Segments.

8.8.1 To View and Edit the Tree Zones That Have Been Added to the Project Map
1. Click the Tree Zones Detail sub-pane.
2. Click Tree Zones in the left column to view and edit the list of tree zones.
3. Click Points in the left column to view and edit the points of each tree zone.
4. Click Segment in the left column to view and edit the segments of each tree zone.

8.9 Ground Zones Detail Sub-Pane
The Ground Zones Detail sub-pane contains the details for each ground zone that has been added to the project map. You can view and edit the Ground Zones, Points, and Segments.

8.9.1 To View and Edit the Ground Zones That Have Been Added to the Project Map
5. Click the Ground Zones Detail sub-pane.
6. Click Ground Zones in the left column to view and edit the list of ground zones.
7. Click Points in the left column to view and edit the points of each ground zone.
8. Click Segments in the left column to view and edit the segments of each ground zone.

8.10 Contour Zones Detail Sub-Pane
The Contour Zones Detail sub-pane contains the details for each contour zone that has been added to the project map. You can view and edit the Contour Zones, Points, and Segments.

8.10.1 To View and Edit the Contour Zones That Have Been Added to the Project Map
1. Click the Contour Zones Detail sub-pane.
2. Click Contour Zones in the left column to view and edit the list of contour zones.
3. Click Points in the left column to view and edit the points of each contour zone.
4. Click Segments in the left column to view and edit the segments of each contour zone.

8.11 User-Defined Vehicles Detail Sub-Pane
The User Defined Vehicles Detail sub-pane contains the details for each user defined vehicle that has been added to the project map. You can view and edit the user defined vehicles.

8.11.1 To View and Edit the User-Defined Vehicles That Have Been Added to the Project Map
1. Click the User Defined Vehicles Detail sub-pane.
2. Click UDVs in the left column to view and edit the list of user defined vehicles.
8.12 Output Detail Sub-Pane

The Output Detail sub-pane is an application log that provides an idea of what is happening at a given moment. The Output Detail sub-pane lists the details for the outputs that were created for the open project.

8.13 Project Information Detail Sub-Pane

The Project Information Detail sub-pane lists the project details for the open project.

8.14 Calculation Results Detail Sub-Pane

The Calculation Results Detail sub-pane lists the calculation results of the noise model operations for the open project after the receiver calculations have been generated.

9. Drawing on the Map

In order to calculate traffic noise levels affecting a specific area TNM Objects must be added to the map. Items that can be drawn on the map are as follows:

- Adding Receivers to the Map
- Adding Barriers to the Map
- Adding a Roadway to the Map
- Adding Terrain Lines to the Map
- Adding Building Rows to the Map
- Adding a Roadway to the Map

Traffic Noise Levels originate from traffic on roadways. As vehicles accelerate and decelerate, the noise emitted increases or decreases based on the contour of the roadway and the direction of traffic flow. To calculate how much noise is emitted from traffic that affects designated areas, a Roadway must be defined to provide a source of the road noise. Each Roadway that is added must be applied directionally (i.e. if a highway has two-way traffic, two roadways with opposite directions must be added to the map).

9.1.1 To add a Roadway
1. Click the Roadway icon. The Roadway Defaults window appears.
2. Make sure that the “Enable Object Add” Button is enabled and click a point on the map where you want to begin the Roadway.
3. Click a secondary point on the map. A line will appear as you continue to draw the Roadway.
4. Click as many mid-points as you want to draw the Roadway.
5. Double click the end point location for the roadway. A black directional line and black circles appear on the map showing the starting point, mid-points, and end point indicating the Roadway has been applied.

Note: For multiple lane roads, individual Roadways must be added equaling the number of lanes on the actual road in the correct direction of traffic flow.

Note: To delete the Roadway, right click on the Roadway and select Delete.

Now that a Roadway has been added you can edit the details of the Roadway in the ROADWAYS DETAIL SUB-Pane.

### 9.2 Adding Terrain Lines to the Map

Terrain Lines show the location of surrounding terrain and the horizontal and vertical attributes of the terrain. Terrain lines are used to show where specific areas may be of a certain height or length that they provide barriers or cause an increase in traffic noise levels.

#### 9.2.1 To add a Terrain Line
1. Click the Terrain Line icon . The Terrain Line Defaults window appears.
2. Make sure that the “Enable Object Add” Button is enabled and click a point on the map where you want to begin the Terrain Line.
3. Click a secondary point on the map. A line will appear as you continue to draw the Terrain Line shape.
4. Click as many mid-points as you want to draw the Terrain Line shape.
5. Double click the end point location for the Terrain Line. A polygon with green lines and red circles appear on the map indicating the Terrain Line polygon has been applied.

Note: To delete the Terrain Line, right click on the Terrain Line and select Delete.

Now that a Terrain Line has been added you can edit the details of the Terrain Line in the TERRAIN LINES DETAIL SUB-PANE.

### 9.3 Adding Building Rows to the Map

Building Rows consist of rows of buildings between roadways and receivers that act like barriers to reduce sound levels. Building Rows that have gaps allow noise levels to travel through these gaps. Building Rows provide sound dampening but at a decreased level due to these gaps.

#### 9.3.1 To add Building Rows

1. Click the Building Rows icon . The Building Rows Defaults window appears.
2. Make sure that the “Enable Object Add” Button is enabled and click a point on the map where
you want to begin drawing the Building Row.

3. Click a secondary point on the map. A line will appear as you continue to draw the Building Row shape.

4. Click as many mid-points as needed to create the shape of the Building Row.

5. Double click the end point location for the Building Row. Dotted red lines with red circles in the shape of the building drawn will appear on the map indicating the building row has been applied.

Note: To delete the Building Row, right click on the Building Row and select Delete.

![Figure 41 Added Building Rows in Plan Builder](image)

Now that a Building Row has been added you can edit the details of the Building Row in the **BUILDING ROWS DETAIL SUB-PANE**.

- **ADDING TREE ZONES TO THE MAP**
- **ADDING GROUND ZONES TO THE MAP**
- **ADDING CONTOUR ZONES TO THE MAP**

TNM uses these items to analyze noise emission levels and provides a way to manipulate the items drawn to cause an effect on the traffic noise levels. Without these specific items added to the map, TNM could not model noise levels to assist in the design and development of traffic noise barriers. Click each item above to learn how to draw the feature on the map.

### 9.4 ADDING RECEIVERS TO THE MAP
In order to calculate traffic noise, receivers must be added to the map. You can add as many receivers to the map as you want to ensure you capture sound frequencies from all of the appropriate locations required to provide a detailed and accurate calculation.

### 9.4.1 To Add a Receiver

1. Click the Receiver icon 🎤. The Receiver Defaults window appears.
2. Press the "D" key on the keyboard and click a point on the map where you want to place a Receiver. A blue circle appears at that point indicating that a Receiver has been applied.

Note: To delete the Receiver, right click on the Receiver point and select Delete.

![Figure 37 An Added Receiver in Plan Builder](image)

Now that a Receiver has been added you can edit the details of the Receiver in the Receivers Details Pane.

### 9.5 Adding Barriers to the Map

When calculating traffic noise, barriers can be added to the map to help block noise abatements at specific locations. Added barriers can be adjusted to produce the desired level of noise abatement.

### 9.5.1 To Add a Barrier

1. Click the Barrier icon 🏦. The Barrier Defaults window appears.
2. Make sure that the “Enable Object Add” Button is enabled and click a point on the map where you want to begin the Barrier.
3. Click a secondary point on the map. A line will appear as you continue to draw the Barrier.
4. Click as many mid-points as you want to draw the Barrier.
5. Double click the end point location for the Barrier. A red directional line and red circles appear on the map showing the starting point, mid-points, and end point indicating the barrier has been applied.

Note: To delete the Barrier, right click on the Barrier and select Delete.

![Figure 38 An Added Barrier in Plan Builder](image)

Now that a Barrier has been added you can edit the details of the Barrier in the **BARRIERS DETAIL SUB-PANE**.

### 9.6 Adding a Roadway to the Map

Traffic Noise Levels originate from traffic on roadways. As vehicles accelerate and decelerate, the noise emitted increases or decreases based on the contour of the roadway and the direction of traffic flow. To calculate how much noise is emitted from traffic that affects designated areas, a Roadway must be defined to provide a source of the road noise. Each Roadway that is added must be applied directionally (i.e. if a highway has two-way traffic, two roadways with opposite directions must be added to the map).

#### 9.6.1 To add a Roadway

6. Click the Roadway icon. The Roadway Defaults window appears.
7. Make sure that the “Enable Object Add” Button is enabled and click a point on the map where you want to begin the Roadway.
8. Click a secondary point on the map. A line will appear as you continue to draw the Roadway.
9. Click as many mid-points as you want to draw the Roadway.
10. Double click the end point location for the roadway. A black directional line and black circles appear on the map showing the starting point, mid-points, and end point indicating the Roadway has been applied.

Note: For multiple lane roads, individual Roadways must be added equaling the number of lanes on the actual road in the correct direction of traffic flow.

Note: To delete the Roadway, right click on the Roadway and select Delete.

Now that a Roadway has been added you can edit the details of the Roadway in the ROADWAYS DETAIL SUB-PANE.

9.7 ADDING TERRAIN LINES TO THE MAP

Terrain Lines show the location of surrounding terrain and the horizontal and vertical attributes of the terrain. Terrain lines are used to show where specific areas may be of a certain height or length that they provide barriers or cause an increase in traffic noise levels.

9.7.1 TO ADD A TERRAIN LINE

6. Click the Terrain Line icon . The Terrain Line Defaults window appears.
7. Make sure that the “Enable Object Add” Button is enabled and click a point on the map where you want to begin the Terrain Line.
8. Click a secondary point on the map. A line will appear as you continue to draw the Terrain Line shape.
9. Click as many mid-points as you want to draw the Terrain Line shape.
10. Double click the end point location for the Terrain Line. A polygon with green lines and red circles appear on the map indicating the Terrain Line polygon has been applied.

Note: To delete the Terrain Line, right click on the Terrain Line and select Delete.

![Figure 40 An Added Terrain Line in Plan Builder](image)

Now that a Terrain Line has been added you can edit the details of the Terrain Line in the **Terrain Lines Detail Sub-Pane**.

### 9.8 Adding Building Rows to the Map

Building Rows consist of rows of buildings between roadways and receivers that act like barriers to reduce sound levels. Building Rows that have gaps allow noise levels to travel through these gaps. Building Rows provide sound dampening but at a decreased level due to these gaps.

#### 9.8.1 To Add Building Rows

6. Click the Building Rows icon ![Building Rows Icon](image). The Building Rows Defaults window appears.
7. Make sure that the "Enable Object Add" Button is enabled and click a point on the map where you want to begin drawing the Building Row.
8. Click a secondary point on the map. A line will appear as you continue to draw the Building Row shape.
9. Click as many mid-points as needed to create the shape of the Building Row.
10. Double click the end point location for the Building Row. Dotted red lines with red circles in the shape of the building drawn will appear on the map indicating the building row has been applied.
Note: To delete the Building Row, right click on the Building Row and select Delete.

![Figure 41 Added Building Rows in Plan Builder](image)

Now that a Building Row has been added you can edit the details of the Building Row in the BUILDING ROWS DETAIL SUB-PANE.

### 9.9 Adding Tree Zones to the Map

When calculating traffic noise, Tree Zones can be added to the map to help block noise levels at specific locations. Tree Zones are made up of heavy wooded areas and thick undergrowth located between the roadway and the receiver.

#### 9.9.1 To add a Tree Zone

1. Click the Tree Zones icon 🌳. The Tree Zones Defaults window appears.
2. Make sure that the “Enable Object Add” Button is enabled and click a point on the map where you want to begin the Tree Zone.
3. Click a secondary point on the map. A polygon will appear while you continue to draw the Tree Zone.
4. Click as many mid-points as you want to draw the Tree Zone polygon.
5. Double click the end point location for the Tree Zone. A green polygon with red circles appears on the map showing the Tree Zone and the mid-points indicating the Tree Zone has been applied.

Note: To delete the Tree Zone, right click on the Tree Zone polygon and select Delete.
Now that a Tree Zone has been added you can edit the details of the Tree Zone in the **Building Rows Detail** sub-pane.

The Building Rows Detail sub-pane contains the details for each building row that has been added to the project map. You can view and edit the Building Rows, Points, and Segments.

### 9.9.2 To View and Edit the Building Rows That Have Been Added to the Project Map

9. Click the Building Rows Detail sub-pane.
10. Click Building Rows in the left column to view and edit the list of building rows.
11. Click Points in the left column to view and edit the points of each building row.
12. Click Segments in the left column to view and edit the segments of each building row.

Tree Zones Detail Sub-Pane.

### 9.10 Adding Ground Zones to the Map

Ground Zones are used to define the type of ground located in the area of interest. The ground type of an area has varying acoustical attenuation characteristics that are used when calculating traffic noise levels. For example, a grass covered area provides more sound dampening than a paved area.

#### 9.10.1 To Add Ground Zones

1. Click the Ground Zone icon ![ground zone icon]. The Ground Zone Defaults window appears.
2. Make sure that the “Enable Object Add” Button is enabled and click a point on the map where...
you want to begin the Ground Zone.
3. Click a secondary point on the map. A polygon will appear as you continue to draw the Ground Zone shape.
4. Click as many mid-points as you want to draw the Ground Zone polygon.
5. Double click the end point location for the Ground Zone. A gray filled polygon with gray lines and red circles appear on the map indicating the Ground Zone polygon has been applied.

Note: To delete the Ground Zone, right click on the Ground Zone and select Delete.

![Figure 43 An Added Ground Zone in Plan Builder](image)

Now that a Ground Zone has been added you can edit the details of the Ground Zone in the **GROUND ZONES DETAIL SUB-Pane**.

## 9.11 Adding Contour Zones to the Map

TNM contour zones define areas where you wish TNM to compute sound level contours, which displays gradations of sound level change within the limits of the contour zone.

### 9.11.1 To add a Contour Zone

1. Click the Contour Zone icon 🌪. The Contour Zone Defaults window appears.
2. Make sure that the “Enable Object Add” Button is enabled and click a point on the map where you want to begin the Contour Zone.
3. Click a secondary point on the map. A polygon will appear while you continue to draw the Contour Zone.
4. Click as many mid-points as you want to draw the Contour Zone polygon.
5. Double click the end point location for the Contour Zone. A blue polygon with red circles appears on the map showing the Contour Zone and the mid-points indicating the Contour Zone has been applied.

Note: To delete the Contour Zone, right click on the Contour Zone polygon and select Delete.

![Figure 44: An Added Contour Zone in Plan Builder](image)

Now that a Contour Zone has been added you can edit the details of the Contour Zone in the GROUND ZONES DETAIL SUB-PANE.

The Ground Zones Detail sub-pane contains the details for each ground zone that has been added to the project map. You can view and edit the Ground Zones, Points, and Segments.

**9.11.2 To View and Edit the Ground Zones That Have Been Added to the Project Map**

9. Click the Ground Zones Detail sub-pane.
10. Click Ground Zones in the left column to view and edit the list of ground zones.
11. Click Points in the left column to view and edit the points of each ground zone.
12. Click Segments in the left column to view and edit the segments of each ground zone.

Contour Zones Detail Sub-Pane.